Treasure Coast

acintsh
®

Users Group

1819 SW Willowbend Lane •
Palm City FL 34990 • (772) 283-5646

MEETING
Thursday Sept. 18
LOCATION - Children’s Services Council
• 211 SE Central Parkway, Stuart 34994 •
In the Green building between Unity Church
and Bridges Montessori. Click on this map
link - http://tinyurl.com/clq2mkk
5 - 6:00 P.M. “Here To Help”
Bring your laptop, iPad or iPhone and enjoy
a format with Beginners tables throughout the
room, where you can just join any group:
• iPad			
• Basic Help
• iPhone		
• Email & Internet		
• iPhoto		
• How can I ...

PRESENTATION:

6 - 6:45 P.M. “What's New From Apple”
Mark & Bob will present and discuss the
new lineup of Apple's exciting iPhone 6,
iPhone 6 Plus, and the Watch!
6:45 - 7 P.M. Snacks
7 - 8:00 P.M. Continue “Here To Help”
Keyboard tip:  is option-shift-k

See you there!

Mouse Tales
Newsletter

September 2014 • Vol. 27 - 9

• Early Front Page Edition •
http://www.tcmug.net
MISSION: Since 1988, TCMUG has provided
a forum for Apple users by creating a member
network to share information and offer support
in the evolving world of technology.

Here's the easiest way to unsubscribe
from annoying emails
It's common practice that newsletters from
retail websites and the like include an "unsubscribe" link in their emails, but that's often
buried under fine print and a swath of ads. At
some point, unsubscribing becomes such a
chore, it's easier to just delete new messages.
In Gmail, look out for an "Unsubscribe" link
at the very top of your email, and Gmail will
remove you from the mailing list.
In Outlook, the "Unsubscribe" link appears
at the bottom of the message window.
~ by Sharon Profis

IN THIS ISSUE -

• Unsubscribe from annoying emails
• Seven cool Siri tricks in iOS 7
• Incredibly Simple Things You
Should Do To Protect Your Privacy
• iTunes can sync Digital Booklets to
iBooks on iOS
• Merging and Removing Unused
Calendars
• Apple Customer Support

Seven cool Siri tricks in
iOS 7
With the arrival of iOS 7, we've
got a smarter, more capable gal
Friday (or, if you've changed Siri's
voice, guy Friday).
1. Change your settings
Although the new Control
Center makes it simple to toggle settings like Airplane Mode,
Bluetooth, and screen brightness,
Siri can now handle these kinds of
settings as well. It's a simple matter of saying, "Turn on Bluetooth,"
or the like.
Even better, if there's a setting
you want but don't know where to
find, let Siri take you there. Say
something like "change font size"
and you'll land at exactly the right
Settings menu.

2. Train her to recognize
unusual names
Is Siri constantly mangling the
name of a friend or co-worker
(like that "Broida" character)?
Gone are the days of manually
tweaking "phonetic name" pronunciations; now you just train Siri so
she always gets it right.
All you do is say "pronounce
[person's name]," then follow the
steps through a simple learning
procedure.

3. Do more with Twitter
Siri used to have fairly basic
Twitter integration, but now she's
totally up on what's trending.
In fact, you can ask things like,
"What's trending on Twitter?",
"What's cheapskateblog saying?"
(or any person/company/handle),
or "Search Twitter for hash tag
[whatever]." Queries like these will
return Twitter-centric results.
4. Choose your search engine

Siri still manages to bungle
certain searches if you don't prefix
them properly.
For better or worse, Microsoft's
Bing is now the default Siri search
engine. (The implementation can
still be screwy, though. If you say
"Mount Everest" or "search for
Mount Everest," you'll get, shockingly, nothing. You have to say
"search the Web for Mount Everest.")
However, you can also prefix
your request with "search Google
for" or "search Wikipedia for," and
Siri will give you the corresponding results -- though using the
former will bounce you into Safari
rather than listing the results in
Siri's own little page.
5. Read your e-mail
As I recall, if you asked old Siri
if you had any new e-mail messages, she could tell you. New Siri can
actually start reading those new

messages to you if you say, "Read
my e-mail." You'll hear the sender's name, the date/time of the
message, and the subject line.
You can also say "read my latest
e-mail" or "Do I have e-mail from
[person]?", the latter helpful for
checking in on messages from,
say, your spouse or boss.
If you want the full message,
just tap the onscreen preview to
open up Mail proper. Or, better
yet, say "Read the [number in the
list] one," as in, "Read the third
one."
6. Turn off navigation
Apple Maps can get you where
you need to go ( most of the time
), but if you've reached a familiar part of your route (like when
you're on your way home) and no
longer need battery-draining GPS
assistance, just tell Siri to "cancel
navigation."
7. Play iTunes Radio
In the mood for a little Classic
Rock? Siri has her finger on the
iTunes Radio dial. You can ask
for an artist or station and she'll
queue it right up. The syntax:
"Play iTunes Radio Classic Rock"
~ Rick Broida
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Incredibly Simple Things
You Should Be Doing To
Protect Your Privacy

Please tell me you have a password protecting this.
Over the weekend, I wound up at
Washington, D.C.’s Trapeze School
with a group of friends. Before
one of them headed up a ladder to
attempt a somersault landing from
the trapeze bar, she handed me her
phone and asked me to take photos.
“What’s the password?” I asked.
“I don’t use one,” she replied. My
jaw dropped as it often does when
someone I know tells me they’re
choosing not to take one of the very
simplest steps for privacy protection, allowing anyone to snoop
through their phone with the greatest of ease, to see whichever messages, photos, and sensitive apps
they please.
So this post is for you, guy with
no iPad password, and for you, girl
who stays signed into Gmail on her
boyfriend’s computer, and for you,
person walking down the street
having a loud conversation on your
mobile phone about your recent
doctor’s diagnosis of that rash thing
you have. These are the really,
really simple things you should be
doing to keep casual intruders from
invading your privacy.

to type in a password before they
can use their phone. C’mon, folks.
Choosing not to password protect
these devices is the digital equivalent of leaving your home or car
unlocked. If you’re lucky, no one
will take advantage of the access.
Or maybe the contents will be
ravaged and your favorite speakers
and/or secrets stolen. If you’re not
paranoid enough, spend some time
reading entries in Reddit Relationships, where many an Internet user
goes to discuss issues of the heart.
A good percentage of the entries
start, “I know I shouldn’t have, but
I peeked at my gf’s phone and read
her text messages, and…”
2. Put a Google Alert on your
name. This is an incredibly easy
way to stay on top of what’s being
said about you online. It takes less
than a minute to do. Go here. Enter
your name, and variations of your
name, with quotation marks around
it. Boom. You’re done.
3. Sign out of Facebook, Twitter, Gmail, etc. when you’re done
with your emailing, social networking, tweeting, and other forms
of time-wasting. Not only will
this slightly reduce the amount
of tracking of you as you surf the
Web, this prevents someone who
later sits down at your computer
from loading one of these up and
getting snoopy. If you’re using
someone else’s or a public computer, this is especially important. Yes,
people actually forget to do this,
with terrible outcomes.
4. Don’t give out your email
address, phone number, or zip
code when asked. Obviously, if a
sketchy dude in a bar asks for your
phone number, you say no. But
when the asker is a uniform-

wearing employee at a store such
as Best Buy, many a consumer
hands over their digits when asked.
Stores often use this info to help
profile you and your purchase. You
can say no. If you feel badly about
it, just pretend the employee is the
sketchy dude in the bar. It's this
easy!
5. Gmailers, turn on 2-step
authentication in Gmail.

The biggest takeaway from the
epic hack of Wired’s Mat Honan
was that it probably wouldn’t have
happened if he’d turned on “2-step
verification” in Gmail. This simple
little step turns your phone into a
security fob — in order for your
Gmail account to be accessed from
a new device, a person (hopefully
you) needs a code that’s sent to
your phone. This means that even
if someone gets your password
somehow, they won’t be able to
use it to sign into your account
from a strange computer. Google
says that millions of people use
this tool, and that “thousands more
enroll each day.” Be one of those
people. The downside: It’s annoying if your phone battery dies or
if you’re traveling abroad. The
upside: you can print a piece of
paper to take with you, says James
Fallows at the Atlantic. Alternately,
you can turn it off when you’re

1. Password protect your
devices: your smartphone, your
iPad, your computer, your tablet,
etc. Some open bookers tell me it’s
“annoying” to take two seconds
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going to be abroad or phone-less.
8. Change Your Facebook
Or you can leave it permanently
settings to “Friends Only.” You’d
turned off, and increase your risk of think with the many Facebook
getting epically hacked. You decide. privacy stories over the years that
6. Pay in cash for embarrassing
items. Don’t want a purchase to be
easily tracked back to you? You’ve
seen the movies! Use cash. One
data mining CEO says this is how
he pays for hamburgers and junk
food these days.
7. Clear your browser history
and cookies on a regular basis.
When’s the last time you did that?
If you just shrugged, consider
changing your browser settings so
that this is automatically cleared
every session. Go to the “privacy”
setting in your Browser’s “Options.” Tell it to “never remember
your history.” This will reduce the
amount you’re tracked online. Consider a browser add-on like TACO
to further reduce tracking of your
online behavior.

everyone would have their accounts
locked down and boarded up like
Florida houses before a hurricane.
Not so. Visit your Facebook privacy settings. Make sure this
“default privacy” setting isn’t set
to public, and if it’s set to “Custom,” make sure you know and are
comfortable with any “Networks”
you’re sharing with.

9. Use an IP masker. When you
visit a website, you leave a footprint
behind in the form of IP information. If you want to visit someone’s
blog without their
necessarily knowing
it’s you — say if you’re
checking out a biz competitor, a love interest,
or an ex — you should
consider masking your
computer’s fingerprint,
which at the very least
gives away your approximate location and
service provider. A person looking at their analytics would
notice me as a regular visitor from
Washington, D.C. for example, and
would probably even be able to tell
that I was visiting from a Forbes
network address. To hide this, you
can download Tor or use an easy
browser-based option like
http://www.HideMyAss.com

iTunes can sync Digital
Booklets to iBooks on iOS
by David Chartier 4/14

iTunes digital booklets media
kind Some music albums from
iTunes Store come with a digital
booklet of art, lyrics, or all sorts of
other stuff artists include.
Usually these booklets just stay
in iTunes, but there is a way you
• in iTunes for Mac, select the digital booklet(s) you want to move
can move them to iBooks for Mac,
to iBooks
which will then let you sync them
•
choose
File > Get Info (Command-i) and, in the media settings
to iBooks on your iPhone and iPad.
window that appears, click the Options tab
If you’re on OS X Mavericks, all
•
change
the “Media Kind” option to “Book”
you need to do is drag the booklet
from iTunes to iBooks (thanks to
Once you do that, the booklet will be moved to the PDF section in
Waly Kerkeboom for help with
iBooks
on your Mac. But, for whatever reason, iBooks doesn’t use iCloud
clarifying this procedure).
to sync PDFs to other devices, so you’ll have to old-school it and use
If you’re on a previous version
iTunes. Whether you plug in your device or use iTunes Wi-Fi Sync, just
of OS X without iBooks, give this
select the Books tab and have at it.
a try:
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OS X: Merging and
Removing Unused
Calendars
~ Melissa Holt

If you’ve ever brought
calendar data in from a few
different sources, you may have
ended up with a pretty long list of
calendars. Would you like to get rid
of some of those without erasing
the events that they have? You’re
in luck—we’re gonna do just that
in today’s Quick Tip. The process
involves exporting one calendar’s
data and importing its events into
a different calendar (essentially
merging the two), then deleting the
original calendar and moving on
with our lives. Sound good? Let’s
do it.
So first, open the Calendar program and click on the calendar
you’d like to get rid of from the
left-hand list.

￼
If you don’t see this, click the
“Calendars” button on the toolbar.
Once you’ve got the correct one
selected, go up to the menus and
choose File> Export> Export.

Then we’re going to reimport it to a different calendar—do that by choosing
File> Import and picking
the .ics file you saved out
a second ago.

￼
The application will then want
to know which of your calendars
you’d like to add those existing
events to. Make sure you pick, say,
one of your current iCloud calendars (or at least one that you know
you want to keep).

￼
Click “OK,” and all of those
events will be brought into that
calendar!
One thing I like to do before I
remove any unwanted calendars
is make certain that the events
imported properly. You can do that
by deselecting every other calendar
in your sidebar so that you only
see the calendars you just imported
from and to:

And here’s a bonus tip for you
guys (hooray!): If you hold down
Command and click any of the
checked boxes next to your calendars, that will deselect all of
them. That’s really useful for
when you want to see the events
on only a calendar or two. (If
you’d like to reselect all of them
at once when you’re finished, just
Command-click one of the empty
boxes. Easy-peasy!)
Anyhow, while you’ve got the
calendars in question selected and
all of your other ones hidden, you
can easily compare events and feel
confident that there’s nothing on
the calendar that you’re about to
remove that didn’t get duplicated
on the destination calendar. Make
sense? All right, you’re ready to
start deleting! To do so, just rightor Control-click on the calendar
you want to remove and pick
“Delete.”

￼

Of course, you’ll get a warning,
but that’s no big surprise. Hey,
thanks for trying to help, computer.
￼
Once you click “Delete” on the
warning pop-up, you’re all finished. Repeat these steps for any
subsequent calendars that you’d
like to remove, and your program
will be all neat and clean and stuff.
Hooray for neat and clean…and,
um, stuff!

Your Mac will ask you where
you’d like to save your calendar
file, so put it somewhere handy.
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Apple Customer Support
What if you have a Mac, an
iPhone, an iPad or two Apple
devices in your household, and
you have a problem. You want to
find out if any of them is still under
warranty (and what that warranty
covers). Turns out you can find out
all that and more in one place —a
place that a lot of Apple users have
never heard of.
You probably know about
Apple's standard Support
website https://www.apple.com/support/
But there is also your own
personal Support Profile page https://supportprofile.apple.com
There, you can view a list of all
of your Apple products, (if you
ever registered them) check their
warranty coverage, access troubleshooting resources, and contact
Apple's support team. Here's how
to take advantage of all that.

Everything you ever bought
If you've ever bought any hardware from Apple — whether from Apple's
online store, or in an Apple retail store, but using your Apple ID — the
company has a record of what you bought and when.
After you log in with your Apple ID and password, you'll get to the
support profile itself. On the left, this page lists a list of your personal information: name, phone number, email addresses and postal address. (Tip:
While you're there, you can edit the information.)
￼
Support-profile landing page
On the right there's a list of every bit of hardware you've bought from
Apple. Below that list, you'll see a list of the support cases you've opened as well as repairs you’ve initiated.
As said above, as long as a purchase is associated with
your Apple ID, Apple has a record of it. If you bought
Apple hardware from another retailer, you can register
that: Click Register & Add Products, and you'll be asked
for a serial number. When you provide one, that item
will be added to your list.
Drilling down
Click an item in your hardware list and you'll see information about it. This is a great place to start if you have
problems with any hardware.
Each item listed on your Apple support profile gives
you information about that item, its warranty coverage,
and more.
The Support Resources tab is useful for troubleshooting. You'll find a number of FAQs, technical notes, links
to downloads and other information that may help you
solve your problem. The Communities is a waste of time,
since too many participants there have uneducated
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postings and too often lead you in
the wrong direction.
If you need specific information,
it is still best to contact a known
knowledgeable Apple expert you
trust (or call your local Apple User
Group), and you can also click Case
Activity, then Create a New Case
with Apple.
￼
Initiating a new service case
from within your support profile
There’s one more reason this support profile is useful. If you register
all of your Apple products, it will
serve as a handy list in case you
need to contact an insurer when one
of them is damaged or stolen. The
support profile won't provide actual
invoices, but it will show which
models you owned.
If your hardware is working fine,
you may never need to access this
page. But when things go wrong
with a Mac or iOS device, or if you
just want to check your warranty
coverage, they can make dealing
with Apple's support team easier for
everyone.

Check out all
the excitement!

~ PB Phoenix 9/14

2015 MEMBERSHIP

Joining the Treasure Coast Macintosh Users Group will keep you from missing out on the best Mac
resource since the mouse — including the Monthly Meetings • Newsletter • Special Interest Groups
and more! Membership is just $30 a year per family - getting your colorful newsletter by e-mail.

q $30 Yearly Dues

Check payable to: TCMUG
(or Treasure Coast Macintosh Users Group)
Mail to:
1819 SW Willowbend Lane • Palm City FL 34990

Name _____________________________________________
Address _______________________________ Apt. _______
City ____________________ State _______ Zip _________
Home Phone __________________ Cell ________________
Email address _______________________________________
Birthday (ex. Sep.24) His ________ Hers _______ Retired? ____
__ Beginner __ Intermediate __ Advanced __ Consultant
Computer model(s) _________________________________
Most used programs ________________________________
__ iPhoto __ Keynote __ Pages __ Numbers __ iWeb
__ Photoshop __ Quicken __ Skype
__ Filemaker __ InDesign __ MS Office

Check what items you use:
__ Scanner
__ iPhone
__ Pages (layouts)
__ iPad
__ Keynote (slides)
__ iPod
__ Numbers (data)
__ iMovie
__ Laptop
__ iChat
__ 2+ computers
__ iDVD
__ iTunes
__ iWeb
__ Digital Camera
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Officers

Helpline

President & Newsletter • Chris Kilbride
283-5646
chris@tcmug.net
Vice President & Publicity • Mark Weinberg
465-4890
mark@tcmug.net
Secretary • Kathy Finnerty		
220-8691
kathy@tcmug.net
Beginners SIG • Carol Vertesch
carol@tcmug.net
283-0843
Hospitality • Anita Farrell (after 12pm)
370-7167
anita@tcmug.net
• Moe Goldy
340-0652
moe@tcmug.net
• Guy Reer guy@tcmug.net
Photos & Graphics • Richard Lewis
287-4948
dick@tcmug.net
Technical Advisor (Apple) • Bob Jorritsma
398-0748
bob@tcmug.net
Video Production • Bill Farrell (after 12pm)
370-6407
bill@tcmug.net
(MagicJack)
924-1084
Member At Large • Tom Stout
288-3737
tom@tcmug.net
Palm Beach Liaison • Dave Sochrin
		
dave@tcmug.net

Comcast
• Bill Farrell - after 12PM
370-6407
bill@tcmug.net
DropBox
• Bill Farrell - after 12PM
370-6407
bill@tcmug.net
FileMaker
• Chris Kilbride
283-5646
chris@tcmug.net
iDVD
• Bob Jorritsma
398-0748
bob@tcmug.net
iMovie		
• Bill Farrell - after 12PM
370-6407
bill@tcmug.net
InDesign
• Chris Kilbride
283-5646
chris@tcmug.net
Internet
• Bob Jorritsma
398-0748
bob@tcmug.net
MagicJack
• Bill Farrell - after 12PM
370-6407
bill@tcmug.net
924-1084
(MagicJack)
OS X
• Bob Jorritsma
398-0748
bob@tcmug.net
Photos & Graphics • Dick Lewis
287-4948
dick@tcmug.net
Websites
• Bob Jorritsma
398-0748
bob@tcmug.net
		• Tom Stout
288-3737
tom@tcmug.net

2014
CALENDAR
Jan. 16 • Feb. 20
March 20 • April 17
May 15 • June 19
July 17 • Aug. 21
Sept. 18 • Oct. 16
Nov. 20 • Dec. 18

*All located at the Children's
Services Council Auditorium
• MONTHLY VIDEOS •
http://www.youtube.com/user/
tcmug/videos
• BOARD OF DIRECTORS •
Friday - Sept. 19 @ Chris'

A variety of programs for Beginners
to Advanced Mac enthusiasts.

MEETING INFO
(772) 283-5646
http://www.tcmug.net
Dues may be paid in person
(cash or check), by mail or
credit card (tcmug.net)

MAILING ADDRESS
Treasure Coast Macintosh
Users Group (TCMUG)
1819 SW Willowbend Lane
Palm City FL 34990

MEETING LOCATION
Children's Services Council • Stuart
http://tinyurl.com/clq2mkk
101 SE Central Parkway, Stuart • (772) 283-5646 •

Green building between Bridges Montessori & Unity Church.
West Palm Beach Apple Store - Gardens Mall:
http://www.apple.com/retail/thegardensmall/
West Palm Beach Apple Store - Wellington Green:
http://www.apple.com/retail/wellingtongreen/
Find Out How:
http://www.apple.com/findouthow/mac/
iPad User Guide for iOS 7 Software • 157 pages

http://manuals.info.apple.com/MANUALS/1000/MA1595/en_US/ipad_user_guide.pdf

iPhone User Guide for iOS 7 Software • 157 pages

http://manuals.info.apple.com/MANUALS/1000/MA1565/en_US/iphone_user_guide.pdf

